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Symantec License and Warranty
Norton AntiVirus™ for Macintosh®

IMPORTANT: PLEASE READ THE TERMS AND
CONDITIONS OF THIS LICENSE AGREEMENT
CAREFULLY BEFORE USING THE SOFTWARE.
SYMANTEC CORPORATION AND/OR ITS
SUBSIDIARIES (“SYMANTEC”) IS WILLING TO
LICENSE THE SOFTWARE TO YOU AS THE
INDIVIDUAL, THE COMPANY, OR THE LEGAL
ENTITY THAT WILL BE UTILIZING THE
SOFTWARE (REFERENCED BELOW AS “YOU”
OR “YOUR”) ONLY ON THE CONDITION THAT
YOU ACCEPT ALL OF THE TERMS OF THIS
LICENSE AGREEMENT. THIS IS A LEGAL AND
ENFORCEABLE CONTRACT BETWEEN YOU
AND SYMANTEC. BY OPENING THIS
PACKAGE, BREAKING THE SEAL, CLICKING
THE “ACCEPT” OR “YES” BUTTON OR
OTHERWISE INDICATING ASSENT
ELECTRONICALLY, OR LOADING THE
SOFTWARE, YOU AGREE TO THE TERMS AND
CONDITIONS OF THIS AGREEMENT. IF YOU
DO NOT AGREE TO THESE TERMS AND
CONDITIONS, CLICK THE “I DO NOT ACCEPT”
OR “NO” BUTTON OR OTHERWISE INDICATE
REFUSAL, MAKE NO FURTHER USE OF THE
SOFTWARE, AND CONTACT SYMANTEC
CUSTOMER SERVICE FOR INFORMATION ON
HOW TO OBTAIN A REFUND OF THE MONEY
YOU PAID FOR THE SOFTWARE (LESS
SHIPPING, HANDLING, AND ANY
APPLICABLE TAXES EXCEPT IN CERTAIN
STATES AND COUNTRIES WHERE SHIPPING,
HANDLING, AND TAXES ARE REFUNDABLE)
AT ANY TIME DURING THE SIXTY (60) DAY
PERIOD FOLLOWING THE DATE OF
PURCHASE.

1. License:

The software and documentation that
accompanies this license (collectively the
“Software”) is the property of Symantec, or its
licensors, and is protected by copyright law.
While Symantec continues to own the Software,
You will have certain rights to use the Software
after Your acceptance of this license. This
license governs any releases, revisions, or
enhancements to the Software that Symantec
may furnish to You. Except as may be modified
by a Symantec license certificate, license
coupon, or license key (each a “License
Module”) that accompanies, precedes, or
follows this license, Your rights and obligations
with respect to the use of this Software are as
follows.

You may:

A. use one copy of the Software on a single
computer. If a License Module accompanies,
precedes, or follows this license, You may make
the number of copies of the Software licensed to
You by Symantec as provided in Your License
Module. Your License Module shall constitute
proof of Your right to make such copies;

B. make one copy of the Software for archival
purposes, or copy the Software onto the hard

disk of Your computer and retain the original
for archival purposes;

C. use the Software on a network, provided that
You have a licensed copy of the Software for
each computer that can access the Software
over that network;

D. after written notice to Symantec, transfer the
Software on a permanent basis to another
person or entity, provided that You retain no
copies of the Software and the transferee agrees
to the terms of this license; and

E. use the Software in accordance with any
additional permitted uses set forth below.

You ma yn ot:

A. copy the printed documentation that
accompanies the Software;

B. sublicense, rent, or lease any portion of the
Software; reverse engineer, decompile,
disassemble, modify, translate, make any
attempt to discover the source code of the
Software, or create derivative works from the
Software;

C. use the Software as part of a facility
management, timesharing, service provider, or
service bureau arrangement;

D. use a previous version or copy of the
Software after You have received and installed
a disk replacement set or an upgraded version.
Upon upgrading the Software, all copies of the
prior version must be destroyed;

E. use a later version of the Software than is
provided herewith unless You have purchased
upgrade insurance or have otherwise
separately acquired the right to use such later
version;

F. use, if You received the software distributed
on media containing multiple Symantec
products, any Symantec software on the media
for which You have not received a permission
in a License Module;

G. use the Software in any manner not
authorized by this license; nor

H. use the Software in any manner that
contradicts any additional restrictions set forth
below.

2. Content Updates:

Certain Software utilize content that is updated
from time to time (including but not limited to
the following Software: antivirus software
utilize updated virus definitions; content
filtering software utilize updated URL lists;
some firewall software utilize updated firewall
rules; and vulnerability assessment products
utilize updated vulnerability data; these
updates are collectively referred to as “Content
Updates”). You shall have the right to obtain
Content Updates for any period for which You
have purchased maintenance, except for those
Content Updates that Symantec elects to make
available by separate paid subscription, or for
any period for which You have otherwise



separately acquired the right to obtain Content
Updates. Symantec reserves the right to
designate specified Content Updates as
requiring purchase of a separate subscription at
any time and without notice to You; provided,
however, that if You purchase maintenance
hereunder that includes particular Content
Updates on the date of purchase, You will not
have to pay an additional fee to continue
receiving such Content Updates through the
term of such maintenance even if Symantec
designates such Content Updates as requiring
separate purchase. This License does not
otherwise permit the licensee to obtain and use
Content Updates.

3. Product Installation and
Required Activation:

There are technological measures in this
Software that are designed to prevent
unlicensed or illegal use of the Software. You
agree that Symantec may use these measures
to protect Symantec against software piracy.
This Software may contain enforcement
technology that limits the ability to install and
uninstall the Software on a computer to not
more than a finite number of times for a finite
number of computers. This License and the
Software containing enforcement technology
require activation as further set forth in the
documentation. The Software will only operate
for a finite period of time prior to Software
activation by You. During activation, You will
provide Your unique product key
accompanying the Software and computer
configuration in the form of an alphanumeric
code over the Internet to verify the authenticity
of the Software. If You do not complete the
activation within the finite period of time set
forth in the documentation, or as prompted by
the Software, the Software will cease to function
until activation is complete, which will restore
Software functionality. In the event that You are
not able to activate the Software over the
Internet, or through any other method specified
during the activation process, You may contact
Symantec Customer Support using the
information provided by Symantec during
activation, or as may be set forth in the
documentation.

L. Sixty (60) Day Money Back
Guarantee:

If You are the original licensee of this copy of
the Software and are not completely satisfied
with it for any reason, please contact Symantec
Customer Service for a refund of the money You
paid for the Software (less shipping, handling,
and any applicable taxes except in certain
states and countries where shipping, handling
and taxes are refundable) at any time during
the sixty (60) day period following the date of
purchase.

5. Limited Warranty:

Symantec warrants that the media on which the
Software is distributed will be free from defects
for a period of sixty (60) days from the date of
delivery of the Software to You. Your sole

remedy in the event of a breach of this warranty
will be that Symantec will, at its option, replace
any defective media returned to Symantec
within the warranty period or refund the money
You paid for the Software. Symantec does not
warrant that the Software will meet Your
requirements or that operation of the Software
will be uninterrupted or that the Software will
be error-free.

TO THE MAXIMUM EXTENT PERMITTED BY
APPLICABLE LAW, THE ABOVE WARRANTY IS
EXCLUSIVE AND IN LIEU OF ALL OTHER
WARRANTIES, WHETHER EXPRESS OR
IMPLIED, INCLUDING THE IMPLIED
WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE, AND
NONINFRINGEMENT OF INTELLECTUAL
PROPERTY RIGHTS. THIS WARRANTY GIVES
YOU SPECIFIC LEGAL RIGHTS. YOU MAY
HAVE OTHER RIGHTS, WHICH VARY FROM
STATE TO STATE AND COUNTRY TO
COUNTRY.

6. Disclaimer of Damages:

SOME STATES AND COUNTRIES, INCLUDING
MEMBER COUNTRIES OF THE EUROPEAN
ECONOMIC AREA, DO NOT ALLOW THE
LIMITATION OR EXCLUSION OF LIABILITY
FOR INCIDENTAL OR CONSEQUENTIAL
DAMAGES, SO THE BELOW LIMITATION OR
EXCLUSION MAY NOT APPLY TO YOU.

TO THE MAXIMUM EXTENT PERMITTED BY
APPLICABLE LAW AND REGARDLESS OF
WHETHER ANY REMEDY SET FORTH HEREIN
FAILS OF ITS ESSENTIAL PURPOSE, IN NO
EVENT WILL SYMANTEC OR ITS LICENSORS
BE LIABLE TO YOU FOR ANY SPECIAL,
CONSEQUENTIAL, INDIRECT, OR SIMILAR
DAMAGES, INCLUDING ANY LOST PROFITS
OR LOST DATA ARISING OUT OF THE USE OR
INABILITY TO USE THE SOFTWARE EVEN IF
SYMANTEC HAS BEEN ADVISED OF THE
POSSIBILITY OF SUCH DAMAGES.

IN NO CASE SHALL SYMANTEC'S OR ITS
LICENSORS' LIABILITY EXCEED THE
PURCHASE PRICE FOR THE SOFTWARE. The
disclaimers and limitations set forth above will
apply regardless of whether You accept the
Software.

7. U.S. Government Restricted
Rights:

RESTRICTED RIGHTS LEGEND. All Symantec
products and documentation are commercial in
nature. The software and software
documentation are “Commercial Items,” as that
term is defined in 48 C.F.R. section 2.101,
consisting of “Commercial Computer Software”
and “Commercial Computer Software
Documentation,” as such terms are defined in
48 C.F.R. section 252.227-7014(a)(5) and 48
C.F.R. section 252.227-7014(a)(1), and used in
48 C.F.R. section 12.212 and 48 C.F.R. section
227.7202, as applicable. Consistent with 48
C.F.R. section 12.212, 48 C.F.R. section
252.227-7015, 48 C.F.R. section 227.7202
through 227.7202-4, 48 C.F.R. section 52.227-
14, and other relevant sections of the Code of
Federal Regulations, as applicable, Symantec's
computer software and computer software



documentation are licensed to United States
Government end users with only those rights as
granted to all other end users, according to the
terms and conditions contained in this license
agreement. Manufacturer is Symantec
Corporation, 20330 Stevens Creek Blvd.,
Cupertino, CA 95014.

8. Export Regulation:

Certain Symantec products are subject to
export controls by the U.S. Department of
Commerce (DOC), under the Export
Administration Regulations (EAR) (see
www.bxa.doc.gov). Violation of U.S. law is
strictly prohibited. You agree to comply with
the requirements of the EAR and all applicable
international, national, state, regional and local
laws, and regulations, including any applicable
import and use restrictions. Symantec products
are currently prohibited for export or re-export
to Cuba, North Korea, Iran, Iraq, Libya, Syria
and Sudan or to any country subject to
applicable trade sanctions. You agree not to
export, or re-export, directly or indirectly, any
product to any country outlined in the EAR, nor
to any person or entity on the DOC Denied
Persons, Entities and Unverified Lists, the U.S.
Department of State's Debarred List, or on the
U.S. Department of Treasury's lists of Specially
Designated Nationals, Specially Designated
Narcotics Traffickers, or Specially Designated
Terrorists. Furthermore, You agree not to
export, or re-export, Symantec products to any
military entity not approved under the EAR, or
to any other entity for any military purpose, nor
will You sell any Symantec product for use in
connection with chemical, biological, or nuclear
weapons or missiles capable of delivering such
weapons.

9. General:

If You are located in North America or Latin
America, this Agreement will be governed by

the laws of the State of California, United States
of America. Otherwise, this Agreement will be
governed by the laws of England and Wales.
This Agreement and any related License
Module is the entire agreement between You
and Symantec relating to the Software and: (i)
supersedes all prior or contemporaneous oral or
written communications, proposals, and
representations with respect to its subject
matter; and (ii) prevails over any conflicting or
additional terms of any quote, order,
acknowledgment, or similar communications
between the parties. This Agreement shall
terminate upon Your breach of any term
contained herein and You shall cease use of and
destroy all copies of the Software. The
disclaimers of warranties and damages and
limitations on liability shall survive
termination. Software and documentation is
delivered Ex Works California, U.S.A. or Dublin,
Ireland respectively (ICC INCOTERMS 2000).
This Agreement may only be modified by a
License Module that accompanies this license
or by a written document that has been signed
by both You and Symantec. Should You have
any questions concerning this Agreement, or if
You desire to contact Symantec for any reason,
please write to: (i) Symantec Customer Service,
555 International Way, Springfield, OR 97477,
U.S.A,, (ii) Symantec Consumer Support, PO
Box 5689, Dublin 15, Ireland, or (iii) Symantec
Customer Service, 1 Julius Ave, North Ryde,
NSW 2113, Australia.

10. Additional Uses and
Restrictions:

A. In the event this Software contains the
Norton Security Center component, any
disclaimer of damages herein shall apply to
such component.
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Before installing Norton AntiVirus, take a moment to
review the system requirements.

System requirements

To use Norton AntiVirus, your computer must have one
of the following supported Mac OS X operating system
versions installed. It must also meet the minimum
hardware and memory requirements.

Macintosh OS X version 10.3, or later

G3 processor or higher

128 MB of RAM

40 MB of available hard disk space for installation
Internet connection required for LiveUpdate
CD-ROM or DVD-ROM drive

Norton AntiVirus does not support Mac OS X versions
earlier than 10.3. If you want to install Norton AntiVirus
on Mac OS X, you must upgrade to Mac OS X 10.3, or a
later version.
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Before installation

Before installing Norton AntiVirus, you should read the
Read Me file for the latest installation information.

To install Norton AntiVirus, you must enter an
Administrator name and password. If you're not sure if
your account is an Administrator account, see “Checking
your login type” on page 10.

Reading the Read Me file

The Read Me file contains a summary of what’s new and
changed in Norton AntiVirus, as well as installation tips.
It contains information that was unavailable at the time
that the User Guide was published.

To read the Read Me file

1 Insert the Norton AntiVirus for Macintosh CD into
your optical disk drive.

2 In the CD window, double-click Read Me.

Checking your login type

The installation procedure requires that you enter an
Administrator name and password. If you do not know if
your login is an Administrator login, you can check it in
System Preferences.

To check your login type
1 On the Apple menu, click System Preferences.

2 C(Click Accounts.
Your login name and type are listed.

If your account is an Administrator account, you can
install Norton AntiVirus software using your current
user name and password.

If your account is a Standard account, you can’t install
using your current account’s user name and password.
For security, you must enter an Administrator user name
and password before installing Norton AntiVirus.



Installation
Installing Norton AntiVirus

Installing Norton AntiVirus

You can install Norton AntiVirus from the Norton
AntiVirus for Macintosh CD, or from a file that you
download.

To install Norton AntiVirus for Macintosh

1

Do one of the following:

« If you are installing from a CD, insert the Norton
AntiVirus for Macintosh CD into the optical disk
drive.

If the CD window doesn’t open automatically, from
the desktop, double-click the CD icon to open it.

= If you downloaded your copy of Norton AntiVirus,
double-click the file that you downloaded.

Double-click Norton AntiVirus Installer.

In the Welcome to the Norton AntiVirus Installer
window, click Continue.

Review the Read Me text, and then click Continue.

In the Software License Agreement window, click
Continue.

In the agreement dialog box that appears, click
Agree.

If you click Disagree, you cannot continue with the
installation.

In the Select a Destination window, select the disk on
which you want to install Norton AntiVirus, and then
click Continue.

Files from previous versions of Norton AntiVirus are
deleted when you install Norton AntiVirus to the
same directory as the old version.

In the Easy Install window, click Install.

If you have other Symantec products that include
Norton AntiVirus installed on your computer, this
button may be labeled Upgrade instead of Install.

In the Authenticate window, type your Administrator
name and password, and then click OK.

n
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10 Click Continue Installation to confirm that you
want to install Norton AntiVirus.

11 Choose whether or not you want to run LiveUpdate.
LiveUpdate requires an Internet connection. If you
have an Internet connection, you should run
LiveUpdate to ensure your software is up-to-date.

12 When installation is complete, click Logout.
You must log out to complete the installation process.

If you can't eject the (D

If you have trouble ejecting the CD after you restart your
computer, try one of the following:

i Quit applications and close documents that are on the

CD before ejecting. If a CD is busy, you cannot eject it.
i Restart your computer. Press and hold the eject
button on the keyboard when your Macintosh restart
chime sounds.

i Ona Macintosh computer with a slot-loading CD-ROM

drive, press and hold the mouse button while starting
up to eject the CD.

For more information on how to eject a CD, refer to the
Mac Help.

After installation

Now that you've installed Norton AntiVirus, you have the
following options:

Task More information

Register your software. See "Registering Norton AntiVirus" on
page 13.

Check for late-breaking news See "Reading late-breaking news" on

about your new software. Use the | page 14.

Internet link in the Norton

AntiVirus folder.
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Connecting to the Internet through

America Online

If you use America Online (AOL) as your Internet service
provider (ISP), you must connect to AOL before you go to
the Symantec software registration page or view Late
Breaking News.

To connect to the Symantec Web site through AOL

1
2

Log on to AOL.

On the AOL Welcome page, click the AOL Internet
browser.

Move the AOL browser and any other open AOL
windows out of the way.

Registering Norton AntiVirus

You can register Norton AntiVirus from the Internet.

)

See "Connecting to
the Internet
through

America Online" on
page 13.

If you use America Online (AOL) to connect to the
Internet, you need to log on to AOL first to register
Norton AntiVirus.

To register Norton AntiVirus from the Internet

1
2

Connect to the Internet.

In the Applications folder on your Macintosh, open
the Symantec Solutions folder, and then double-click
Register Your Software.

Your default Internet browser displays the Symantec
Service & Support registration page.

On the support page, click home & home office/
small business.

On the support page, click registration.

On the register your software page, select Norton
AntiVirus for Macintosh.

Select version 10.0 of the product.

Click continue.
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8 On the register your software page, fill in the required
personal information, and then click submit
registration.

A screen is displayed confirming that your
registration information has been processed.

Reading late-breaking news

Norton AntiVirus creates a Late Breaking News link. This
link lets you see the latest information for your installed
software.

To read late-breaking news

See "Connectingto 1 Connect to the Internet.

:Efoll? gtﬁmet 2 In the Norton AntiVirus folder, double-click Late
America Online” on Breaking News.
page 13. Your default Web browser displays the Symantec Late

Breaking News Web page for your product.

For more information

The product documentation provides assistance for using
Norton AntiVirus. You can find the information that you
need on your computer and on the Web.

Accessing Help

Opening Help in Norton AntiVirus displays the Apple
Help Viewer where you can access a list of Help topics.

To access Help

«» At the top of the main window, on the Help menu,
click Norton AntiVirus Help.

Tips for exploring Help:

i To search for a specific topic, in the search field at the
top of the Help window, enter a term(s).

i Terms that are underlined and blue in the text are
defined in the glossary. Click the word to go to its
definition. Click the left-arrow button to return to the
topic.
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= Links to related topics appear at the end of a topic.

= Some topics include links that open the window in
which you can begin the task described.

Opening the User Guide PDF
The User Guide is available in PDF format on the CD.

To open the User Guide

1 Insert the Norton AntiVirus for Macintosh CD into the
CD-ROM drive.

2 In the CD window, double-click the Documentation
folder.

3 Double-click Norton AntiVirus User Guide.

You can also drag the PDF to your hard disk if you want
to keep a copy on your computer.

Tips for exploring the PDF:

# When you open the PDF, the table of contents appears
in the margin. In the table of contents, click a heading
to jump to that topic.

i To search for a specific topic, use the Find command
on the Edit menu.
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Norton AntiVirus provides a variety of threat protection
and quick access features that help you maintain the
security of your computer.

Virus and threat protection features

Norton AntiVirus monitors your computer for known and
unknown viruses. A known virus is one that Norton
AntiVirus can detect and identify by name. An unknown
virus is one for which Norton AntiVirus does not yet have
a definition.

Norton AntiVirus protects your computer from both
types of viruses, using virus definitions to detect known
viruses, and Bloodhound technology to detect unknown
viruses. Norton AntiVirus uses virus definitions and
Bloodhound technology during scheduled scans and
manual scans, and Auto-Protect uses them to monitor
your computer constantly.
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Norton AntiVirus for Macintosh version 10.0 includes
these antivirus features:

Auto-Protect Provides virus and threat protection as soon as you start
your computer and constant protection while you work.
It eliminates viruses, including macro viruses, and
quarantines and repairs damaged files. It also checks
for viruses every time you use software programs on
your computer, insert CDs or other removable media,
use the Internet, receive email, or copy or save files to
your computer.

Mount Scan Scans removable disks, including (Ds, Zip disks, and
flash drives, to ensure that they don't contain viruses.

Mount Scan allows you to select the kinds of media that
Auto-Protect scans for viruses when you use them with
your computer. This feature lets you prevent scanning of
specific types of (Ds and DVDs, or an iPod, that you
know are virus-free and that you don't want scanned
every time you use them with your computer.

SafeZones SafeZones are locations you designate on your computer
that are protected automatically. Whenever a file is
copied, changed, or added within a SafeZone, Auto-
Protect scans the file for viruses. You can select specific
folders on the computer as SafeZones, or select the
entire hard disk as a SafeZone. If you select the entire
hard disk as a SafeZone, Auto-Protect scans every file
that is created, copied, or modified on your hard disk.
By default, your entire computer is considered a
SafeZone.

LiveUpdate Downloads and installs the latest program updates and
virus definitions automatically to protect your computer
against new threats. Norton AntiVirus uses virus
definition files to recognize viruses and intercept their

activity.
Bloodhound Bloodhound is the Norton AntiVirus scanning technology
technology for detecting new and unknown viruses. It detects

viruses by analyzing an executable file's structure,
behavior, and other attributes, such as programming
logic, computer instructions, and any data contained in
the file.
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Windows virus
repair

Archived file
scanning

Repairs Windows and DOS viruses so hidden PC viruses
cannot be planted in your computer and spread to
Windows computers.

Scans and repairs files inside archives, such as .sit files.

Quick access features

Using these features, you can quickly access Norton
AntiVirus tools and stay informed about the latest virus
threats.

Tool drawer
Norton QuickMenu

Contextual Finder
menu

Global Threat
Assessment
Dashboard widget

Access your antivirus tools
Access to Auto-Protect settings
Virus scan any selected file from the Finder

View the top virus threats and latest virus threats from
the Dashboard (available in Mac 0S X 10.4 or later)
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These topics include general information about how to
start and quit Norton AntiVirus, and how to access more
information.

Starting and quitting Norton AntiVirus

You don’t have to open the Norton AntiVirus program to
be protected from viruses if you have Auto-Protect
running. You do have to open Norton AntiVirus when you
want to:

i Start a manual virus scan of your computer.

i Start a manual LiveUpdate session.

2 Schedule Norton AntiVirus to run unattended virus
scans or LiveUpdate downloads.

i Customize virus protection options.

To start Norton AntiVirus
1 Open the Applications folder.
2 Double-click Norton AntiVirus.
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Quitting Norton AntiVirus closes the Norton AntiVirus
window, but leaves Auto-Protect and scheduled
LiveUpdate events running.

To quit Norton AntiVirus
Do one of the following:

i On the Norton AntiVirus menu, click Quit Norton
AntiVirus.

% Press Command-Qu

Enabling and disabling Auto-Protect

By default, Auto-Protect guards against viruses as soon
as your computer starts. It checks programs for viruses
as they run and monitors your computer for any activity
that might indicate the presence of a virus. Running a
Norton AntiVirus manual scan is not necessary as long
as Auto-Protect is enabled. Auto-Protect interception
prevents viruses from infecting your computer, and you
should keep Auto-Protect turned on.

To disable Auto-Protect temporarily

« On the Norton QuickMenu, click Norton AntiVirus >
Disable Auto-Protect.
When you disable Auto-Protect, the Norton
QuickMenu changes the icon for Norton AntiVirus to
remind you that you have disabled your protection.

If you have turned off Auto-Protect, you should enable it
as soon as possible.
To enable Auto-Protect

« On the Norton QuickMenu, click Norton AntiVirus >
Enable Auto-Protect.
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Using the Global Threat Assessment
widget

Users running Mac OS X version 10.4 (Tiger) or later
versions of Mac OS X can use Dashboard. Dashboard is
an application that provides quick access to a collection
of simple tools called widgets. When you install Norton
AntiVirus on a Macintosh capable of running Dashboard,
the installation includes the Global Threat Assessment
widget.

Global Threat Assessment uses your Macintosh’s
Internet connection to display a current list of both the
top two threats and three newest threats from
Symantec’s Security Response Web site.

To view the Global Threat Assessment widget

1 Activate Dashboard, and then display the Dashboard
widget bar.
Consult Mac Help for the various ways you can
activate Dashboard.

2 In the Dashboard widget bar, click Symantec Alerts.

3 In the Global Threat Assessment widget, do any of the

following:

«f Click the name of a virus threat.

The Global Threat Assessment widget opens your
Web browser and displays detailed information
about a virus threat from Symantec’s Security
Response site.

« In the lowerright corner of the widget, click i.
The Global Threat Assessment widget displays the
version of Norton AntiVirus you have installed, the
date you last updated your virus definitions, and
whether Auto-Protect is active.
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Responding to
emergencies

Norton AntiVirus notifies you that it has detected a virus
or other security risk when one of the following has
occurred:

= Auto-Protect has found a virus while monitoring your
computer.

i A virus scan that you scheduled or started manually
has found a virus.

With default settings, Norton AntiVirus automatically
attempts to repair any virus it finds. If it can’t repair the
file, Norton AntiVirus safely quarantines the file, so that
it cannot harm your computer. Usually, Norton AntiVirus
performs these repairs without any action by you.

In certain circumstances, Norton AntiVirus asks you
whether you want to repair, delete, or restore an infected
file. Your responses determine what Norton AntiVirus
does with the infected file.

For more information about a particular virus, refer to the
Symantec Security Response Web site.
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What to do if a virus is found by Auto-

Protect
When a virus is found while Auto-Protect is running, an
alert displays what happened, and what your options are.
Read the alert message carefully to determine whether
you need to do anything.

Resolution Your action

Repaired infected
file

Asks for your
approval before
repairing infected
file

Unable to repair
infected file

None needed.

Approve the repair. If you don't repair the file, it is left
as it is on your computer.

If you have set the Auto-Protect Repair preference to
Manually repair infected files, Auto-Protect informs you
of infected files, and asks for your approval before
repairing them.

See "To manually repair an infected file that has been
detected but not repaired"” on page 26.

Open Quarantine.

In a few cases, Auto-Protect may not be able to repair
an infected file, whether or not you have preferences set
to Automatic Repair. With default preferences on, if
Auto-Protect cannot repair a file, it puts it in
Quarantine.

See "Repairing, deleting, and restoring files in
Quarantine” on page 28.

To manually repair an infected file that has been

detected but not repaired

i In the Norton AntiVirus Alert, click Yes to repair the
file.
If the file cannot be repaired, Auto-Protect
automatically quarantines it.

Do not click No in the Norton AntiVirus Alert unless you
are sure the file is safe. If you do not repair a detected
file, it is left as it is on your computer.



Responding to emergencies | 27
If a virus is found during a manual scan |

If a virus is found during a manual scan

If you are scanning with Norton AntiVirus and a virus is
found, the scan window shows you the name of the
infected file. Usually, infected files are repaired or
quarantined automatically and you don’t have to do
anything else. To determine if the file was repaired or if
you need to take further action, check the status of the
file in the scan window. If the file was not quarantined,
you can attempt to repair or delete the file.

To check the status of infected files in the scan
window

« In the Virus Scan window, under Scan Results, select
the infected file.

Repairing infected files

If an infected file in the scan window was not repaired or
placed in Quarantine, you can initiate the repair yourself.

To repair infected files

1 In the scan results list, select the files to repair.

2 Click Repair.

3 After repairing all infected files, scan your disks again
to verify that there are no other infected files.

4 Check the repaired files to make sure that they
function properly.
For example, if you repaired a word processing
program, edit a document using the word processing
program to make sure that it has been repaired
correctly.

If you have set Auto-Protect to ignore removable media,
you can use Norton AntiVirus to scan and repair
removable media manually.

To repair infected removable media
1 Open Norton AntiVirus.

2 In the Norton AntiVirus main window, select the
media to scan.
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3 Click Scan/Repair.
The Virus Scan window displays the name and status
of any infected files found by the scan. Selecting the
name of a file in the Virus Scan window enables you
to repair, delete, or learn more about a file.

If Norton AntiVirus can't repair a file

If Norton AntiVirus cannot repair the infected file, first
make sure you have scanned with the latest virus
definitions. If you are not sure that you have the latest
definitions, use LiveUpdate. Then scan your hard disk
with the latest virus definitions.

About Norton AntiVirus Quarantine

Sometimes Norton AntiVirus detects an unknown virus
that cannot be eliminated with the current set of virus
definitions. Norton AntiVirus prompts you to put the file
in Quarantine, or it quarantines it automatically. Files
that are in Quarantine have been removed from their
original location on your computer and are isolated, so
that they cannot spread or reinfect your computer. You
can’t view the file in the Finder or use the file while it is
in Quarantine. This prevents you from accidentally
opening the file and spreading the virus.

Repairing, deleting, and restoring files in

Quarantine

The Quarantine window displays the items that Norton
AntiVirus has detected as potentially harmful, and has
put in Quarantine to prevent the file from infecting your
computer.

You can leave a file in Quarantine without doing any
harm to your computer, but you can’t view the file in the
Finder or use the file while it is in Quarantine. Depending
on whether you want to keep the file, you can repair,
delete, or restore quarantined files from the Quarantine
window.
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An administrator password is required to perform
actions on files in Quarantine.

To repair, delete or restore a file in Quarantine
1 Open Norton AntiVirus.
2 On the Tools menu, click Quarantine.

3 If the buttons in the Quarantine window are dimmed,
click the lock icon and type an administrator name
and password.

4 In the Quarantine window, select the file you want to
take action on. Your options are:

Repair

Delete

Restore

Use Repair if you want to try to repair a quarantined file
because the file contains information that you want to
keep. Use this action if you have received new virus
definitions since the file was added to Quarantine. New
virus definitions may be able to repair a file that
couldn't previously be repaired.

If you don't need the contents of the file in Quarantine,
you can permanently remove it from your computer by
clicking the Delete button.

If you're sure the file in Quarantine does not contain a
virus, you can move the file back to its original location
on your computer by clicking the Restore button.
Restoring a file does not repair it.

Looking up virus names and definitions

You can look up a virus name from within Norton
AntiVirus. The Virus Definitions Info window lists the
viruses in the current virus definitions file. You can
export the list to a text file. You can also search the list
for a specific virus. To make sure you have the latest
virus definitions, run LiveUpdate.

To look up virus names
1 On the Tools menu, click Virus Info.
2 Type the name or part of the name of the virus.

29
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The Virus Definitions Info window can provide you with
detailed information about a virus if you have an active
Internet connection. Detailed information is obtained
from the Symantec Security Response Web site and
displayed in separate window.

To look up detailed information about a virus

1 In the Virus Definitions Info window, click the name
of a virus.
2 Click Learn More.

Looking up virus definitions on the Symantec

Web site

Because of the large number of viruses, the Virus
Definitions Info file does not include descriptions of each
virus. The Symantec Security Response Web site
contains a complete list of all known viruses and related
malicious code, along with descriptions.

To look up virus definitions

1 Point your browser to the Symantec Security
Response Web site at:
http://securityresponse.symantec.com

2 Click View all virus threats.

3 Do one of the following:
= Type the name of a virus for which to search.
== Scroll through the alphabetical list to locate a

virus.
4 Click a virus’s name to read its description.



Frequently asked
questions

This section addresses some frequently encountered
problems and troubleshooting steps. If you cannot
resolve your problem using this information, consult the
Read Me file on the Norton AntiVirus for Macintosh CD
or in the Symantec Solutions folder.

For a comprehensive list of the latest troubleshooting
tips, see the Symantec Service and Support Web site at:
www.symantec.com/techsupp/

Exploring the Symantec support Web site

The Symantec support Web site provides extensive
information about Norton AntiVirus. You can access free
online support to find information about product
subscriptions, product registration, and common support
issues. Fee-based phone support is also available to help
solve your problem.

To explore the Symantec support Web site

1 On the Internet, go to www.symantec.com/techsupp

2 On the support Web page, under home & home office/
small business, click Continue.

3 On the home & home office/small business Web page,
click access free online support.
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4 Follow the instructions on the Web site to get the
information you need.

If you cannot find what you are looking for using the free
online support pages, you can call Symantec to use fee-
based technical support services, or you can search the
Web site.

To search the Symantec support Web site

1 On the left side of any Web page in the Symantec
support Web site, click search.

2 Type a word or phrase that best represents the
information for which you are looking.
For tips on entering your search text, click help at the
bottom of the page.

3 Check the area of the Web site that you want to
search.

4 Click search.

What if | have problems installing?

See "Installation”
on page 9.

If you encounter any problems installing Norton
AntiVirus, try any of the following:

= Restart Norton AntiVirus
= Reinstall Norton AntiVirus

= Copy the Norton AntiVirus installer from the Norton
AntiVirus for Macintosh CD to your Mac and install
from there.

You must know your administrator password to install
Norton AntiVirus.

Why does Auto-Protect fail to start?

If Auto-Protect fails to load, make sure that all engine
files and virus definitions are installed. Norton AntiVirus
Auto-Protect does not run without them.

Also, make sure that Auto-Protect is enabled.
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To enable Norton Auto-Protect
1 Open System Preferences.
2 In System Preferences, click Norton Auto-Protect.
3 Check Enable Norton Auto-Protect.
You may need to click the padlock at the bottom of the

Preference window and enter an Administrator name
and password before you can enable Auto-Protect.

Why does Norton AntiVirus report that a
file is invalid or can't be found?

This is an indication that one of the files making up the
virus definitions is damaged or otherwise invalid.

See “Installing To repair a damaged or missing virus definitions file

Norton AntiVirus" . R
on page 1. 1 Uninstall Norton AntiVirus.

2 Reinstall Norton AntiVirus.

3 Run LiveUpdate and update your virus definitions.
This restores the current versions of the items in the
Norton AntiVirus Additions folder.

Why aren't all files scanned?

Norton AntiVirus scans only those files for which your
account has access privileges. For example, if you are
logged on as an Administrator, Norton AntiVirus scans
all the files to which you have access as an
Administrator. If you are logged on as a standard user,
Norton AntiVirus scans only those files to which you
have access as a standard user.

To only list scanned files

< In Preferences, on the Scan tab, check Do not list
permissions errors when scanning.
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How do | rescan files that have already
been scanned?

The Norton AntiVirus QuickScan file records whether
you have already scanned a file using the currently
installed virus definitions and libraries. If not, the file is
scanned. If you want all files to be scanned regardless,
you can use Norton AntiVirus to delete the QuickScan
file located at the root of each disk. In recent versions of
Norton AntiVirus, the file is named NAVMac800QSFile.

To remove the QuickScan file

1

6
7

In the Norton AntiVirus window, on the File View tab,
check Show Invisible Files.

Select your hard disk.

Select the QuickScan file.

If there are QuickScan files from previous versions of
Norton AntiVirus, select them as well. Previous
versions of Norton AntiVirus had QuickScan files
named NAV QuickScan 5.0, NAV 6.0 QuickScan, NAV
7.0 QuickScan or NAVMac800QSFile.

Click Move To Trash.

Click OK.

In certain situations, Norton AntiVirus may leave the
QuickScan file in place but delete its contents. When
this happens, Norton AntiVirus provides a message
informing you that the file’s contents have been
deleted. You do not have to perform the next two steps
when the QuickScan file’s contents are deleted.

Quit Norton AntiVirus.

In the Finder, click Empty Trash.

After you have deleted the QuickScan file, the first scan
with the new virus definitions will be slower.
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Why can't | update virus definitions
using LiveUpdate?

In some rare cases such as immediately after the
emergence of a new virus, the LiveUpdate servers may
be very busy and it may be difficult to get a connection.
In such cases, keep making connection attempts and you
should eventually be successful.

When using LiveUpdate, make sure that your Internet
connection is working by testing the connection with an
Internet application, such as your Web browser.
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Service and support
solutions

The Service & Support Web site at
http://service.symantec.com supports Symantec
products. Customer Service helps with nontechnical
issues such as orders, upgrades, replacements, and
rebates. Technical Support helps with technical issues
such as installing, configuring, or troubleshooting
Symantec products.

Methods of technical support and customer service can
vary by region. For information on support offerings in
your region, check the appropriate Web site listed in the
sections that follow.

If you received this product when you purchased your
computer, your computer manufacturer may be
responsible for providing your support.

Customer service

The Service & Support Web site at
http://service.symantec.com tells you how to:

i Subscribe to Symantec newsletters.

i Locate resellers and consultants in your area.

i Update your product registration.

= Find out about orders, returns, or a rebate status.

i Access Customer Service FAQs.

i Post a question to a Customer Service representative.
i Obtain product information, literature, or trialware.

For upgrade orders, visit the Symantec Store at:
http:;//www.symantecstore.com
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Technical support

Technical support

Symantec offers two technical support options for help
with installing, configuring, or troubleshooting Symantec
products:

Online Service and Support

Connect to the Symantec Service & Support Web site
at http;//service.symantec.com, select your user type,
and then select your product and version. You can
access hot topics, Knowledge Base articles, tutorials,
contact options, and more. You can also post a
question to an online Technical Support
representative.

PriorityCare telephone support

This fee-based (in most areas) telephone support is
available to all registered customers. Find the phone
number for your product at the Service & Support
Web site. You'll be led through the online options
first, and then to the telephone contact options.

Support for old and discontinued versions

When Symantec announces that a product will no longer
be marketed or sold, telephone support is discontinued
60 days later. Technical information may still be
available through the Service & Support Web site at:
http://service.symantec.com
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Subscription policy

If your Symantec product includes virus, firewall, or Web
content protection, you may be entitled to receive
updates via LiveUpdate. Subscription length varies by
Symantec product.

After your initial subscription ends, you must renew it
before you can update your virus, firewall, or Web
content protection. Without these updates, you will be
vulnerable to attacks.

When you run LiveUpdate near the end of your
subscription period, you are prompted to subscribe for a
nominal charge. Simply follow the instructions on the
screen.

Worldwide service and support

Technical support and customer service solutions vary
by country. For Symantec and International Partner
locations outside of the United States, contact one of the
service and support offices listed below, or connect to
http://service.symantec.com and select your region or
language under Global Support.
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Service and support offices

North America

Symantec Corporation http://www.symantec.com/
555 International Way

Springfield, OR 97477

U.S.A.

Australia and New Zealand

Symantec Australia http://www.symantec.com/region/
Level 2, 1 Julius Avenue reg_ap/

North Ryde, NSW 2113 +61 (2) 8879-1000

Sydney Fax: +61 (2) 8879-1001

Australia

Europe, Middle East, and Africa

Symantec Ltd http://www.symantec.com/region/
Consumer Services & Support reg_eul/

PO Box 5689 +353 (1) 811 8032

Blanchardstown, Dublin 15

Ireland

Latin America

Symantec Brasil Portuguese:

Market Place Tower http://www.service.symantec.com/br
Av. Dr. Chucri Zaidan, 920 Spanish:

12° andar http://www.service.symantec.com/mx
Sdo Paulo - SP Brazil: +55 (11) 5189-6300

CEP: 04583-904 Mexico: +52 55 5322 3681 (Mexico DF)

Brasil, SA 01 800 711 8443 (Interior)

August 12, 2004
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